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What’s New in
Chief Architect X10

Welcome to Chief Architect X10. This guide has been written to help our upgrading customers make a smooth 
transition from earlier versions of Chief Architect to Chief Architect X10. 

Contents
•      Getting Started CheckList
•      Considerations for Legacy Files
•      New and Improved Features

Getting Started CheckList
There are many new features in Chief Architect X10, and many existing features have changed. The following 
checklist suggests steps you should take before migrating your files to Chief Architect X10. More information 
about each of these steps can be found after the checklist.

1.      Check for and Install Program Updates
2.      Review the New Features List
3.      Migrate Legacy Library Files
4.      Migrate Custom Graphics Files
5.      Review Your Preferences Settings
6.      Create new custom Template Plan and Layout files
7.      Set up Custom Toolbar Configurations
8.      Backup Entire Plan
9.      Check chiefarchitect.com for more information

1. Check for and Install Program Updates

Program updates contain improvements to the original release version and we recommend using the most 
current version available. By default, Chief Architect checks for program updates every day when you launch 
the program. Please note that program updates are available for download, which means that you need internet 
access to acquire them.

You can check for updates at any time: 

• Select Help> Download Program Updates from the menu. 
• Visit the Program Updates page on the Chief Architect Web site at chiefarchitect.com. 
2. Review the New Features List 

http://www.chiefarchitect.com/
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There are a number of important reasons why you should familiarize yourself with the new and improved 
features in Chief Architect X10:

• New and improved features allow you to produce drawings more efficiently, so it is to your advantage to 
use them. 

• Some changes to existing functionality may affect your accustomed drawing style and thus your productiv-
ity if you are not aware of them. 

• New features may affect your choice of settings in your template files, as well as your preferred Preferences 
settings. 

See “New and Improved Features” on page 8. 

3. Migrate Legacy Library Files 

Library content from previous program versions cannot be installed or copied into the Chief Architect X10 
library. If you have Chief Architect version X5 through X9 installed on your computer, the Migrate Settings 
dialog will display after you activate the license, allowing you to migrate Preference settings, toolbars, library 
content, and more for use in Chief Architect X10. If multiple legacy versions are present on the system, only 
the data associated with the most recent will be migrated. 

You can import library files from versions X1 through X5 at any time by selecting Library> Import Library 
(.calib, .calibz) from the program menu. In addition, library files from versions 10 and prior can be imported 
by selecting Library> Convert Legacy (.alb) Library Files from the program menu.

4. Migrate Custom Graphics Files

If you have custom graphics files, including textures, images or backdrops, that you were using in a previous 
program version, you can copy them manually using your operating system for use in Chief Architect X10. 

• Copy custom texture files to the Chief Architect X10 Textures folder located in the Chief Architect X10 
Data folder. 

• Copy custom image files to your Chief Architect X10 Images folder located in the Chief Architect X10 
Data folder. 

• Copy custom backdrop files to your Chief Architect X10 Backdrops folder located in the Chief Architect 
X10 Data folder. 

In Chief Architect X9 through X1, custom graphics were saved in the Chief Architect Data folder, as they are 
in version X10. In version 10, they were located in the program’s installation directory, in folders that began 
with “My”. Custom backdrops, for example, were saved in “My Backdrops”. 

Texture and image files are not listed in the Library Browser. These files can be assigned to material and image 
objects, however, which are stored in the library so it is important to retain them.

5. Review Your Preferences Settings 

Although you can migrate your Preferences settings from Versions X5 through X9 into Version X10, the 
settings that are available in Version X10 may differ from previous program versions. You should review all the 
settings in the Preferences dialog to make sure that they are set to suit your drawing needs.

6. Create new custom Template Plan and Layout files 

Chief Architect X10 installs a selection of template plan and layout files that have been set up to take 
advantage of the program’s updated tools and features. Although you can migrate your template files for use in 
Version X10, for best results it is recommended that you either: 

• Use the installed templates when creating new plans and layout files in Chief Architect X10
• Use the installed templates as the basis for creating new custom templates.

If you choose to continue using custom template files that you created in a previous program version, it is very 
important that you take the time to carefully review all the default settings in the file, making sure that they will 
continue to suit your needs in X10. First, make copies of your custom templates in the Chief Architect X10 
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Templates directory The Templates directory is located in the Chief Architect X10 Data folder. Next, open each 
template as you would a regular plan or layout file, by selecting File> Open, and then save any changes you 
make by selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout template from 
the same program version, as well. As with a template plan, take the time to go through the layout template’s 
defaults and make sure they are suited for use in X10 and that their line weight scales do not conflict with those 
in your template plans.

7. Set up Custom Toolbar Configurations 

It is possible to migrate toolbar configuration files from previous versions to Chief Architect X10; however, it 
is possible that your migrated toolbars will be missing new tools available in Version X10. 

We recommend that you set up your custom toolbars the way you would like them in Chief Architect X10. You 
may find it most effective to customize your toolbars as you get used to working in the new program version, 
rather than beforehand.  

8. Backup Entire Plan

Before migrating a legacy file created in Chief Architect X9 or prior, it is a good idea to open the plan in the 
program version in which it was created and use the Backup Entire Plan tool (Export Entire Plan in version X3 
and prior) to export the plan with all associated support files, including textures, backdrops and images.  

9. Check chiefarchitect.com for more information 

If you have additional questions about the changes in Chief Architect, up to date information is available in the 
Support section of our web site. You can also post questions on the ChiefTalk web forum at 
chieftalk.chiefarchitect.com.

Considerations for Legacy Files
As in all software, every new program version introduces changes to its functionality as well as to the user 
interface. If you choose to bring a project forward, be sure to take a few moments to look it over in the new 
version and confirm that the new functionality does not require you to make any modifications. Particularly if 
you have an approaching deadline, you may find it best to finish the current project in the version of the 
software in which you began it. 

Chief Architect X10 can open the .plan and .layout files from prior versions. Files with the older .pl and .la file 
extensions are no longer supported and cannot be opened by Chief Architect X10. Before opening any files 
created in earlier versions of Chief Architect, it is important to be aware of changes made in the newest version 
and the effect they may have on your legacy plan and layout files. For details, see “Files Created in Version X7 
and Prior” on page 4, “For Files Created in Version X2 and Prior” on page 6. 

Please note that files saved in the latest program version cannot be read by older versions of the software. 
When a legacy file is saved in the version X10, an unaltered copy of the original file is created in the Chief 
Architect X10 Data folder, under Archives, which can still be opened in the original version.

• “Files Created in Version X9 and Prior” on page 4
• “For Files Created in Version X8 and Prior” on page 4
• “Files Created in Version X7 and Prior” on page 4
• “Files Created in Version X6 and Prior” on page 5
• “For Files Created in Version X5 and Prior” on page 5
• “For Files Created in Version X4 and Prior” on page 5
• “For Files Created in Version X3 and Prior” on page 6
• “For Files Created in Version X2 and Prior” on page 6

https://chieftalk.chiefarchitect.com/
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Files Created in Version X9 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X9 or 
prior, bear in mind the following:

1. Parallel Lights

In Chief Architect X9 and prior, Parallel Light sources could be specified for electrical light fixtures and Added 
Lights. In Version X10, Parallel Lights are no longer supported. In legacy plans opened in Version X10, any 
Parallel Light sources will be converted to Spot Lights.

2. Brick Ledges

In Chief Architect X9 and prior, brick ledges were not represented in floor plan view. In Version X10, brick 
ledges are drawn in plan view on the “Slabs” layer in stem wall and grade beam foundations, and on the “Walls, 
Foundation” layer in monolithic slab foundations. When a legacy file is opened in Version X10, brick ledges, if 
present, will be drawn.

3. Window Types

In Chief Architect X9 and prior, the %type% text macro for windows reported some Window Types using 
abbreviations. In Version X10, the abbreviations were replaced with full words. When a legacy file is opened in 
Version X10, the width of Window Schedules may be affected, as may the width of columns in saved Materials 
Lists.

4. Joist Direction Lines

In Chief Architect X9 and prior, Joist Direction Lines described all platform framing as “joists” and used 
nominal lumber sizes in whole inches in US Unit plans. In Version X10, the platform’s framing Structure Type 
is reported and in US Unit plans, the size is described in fractional inches. When a legacy file is opened in 
Version X10, Joist Direction Lines will use the new, more accurate labeling.

5. Custom Schedule Columns

In Chief Architect X9 and prior, custom schedule columns could be created by adding a Sub Category to a type 
of object on the Categories panel of the Preferences dialog. In Version X10, Sub Categories can no longer be 
created in this manner. When a legacy file is opened in Version X10, any Sub Categories shown as custom 
schedule columns will be converted to Custom Fields.

For Files Created in Version X8 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X8 or 
prior, bear in mind the following: 

1. Layer Names

In Chief Architect X8 and prior, turning off the Modify Name in all Layer Sets option made it possible to 
assign different names to the same layer in different layer sets. In Version X9,this option was no longer 
supported. When a legacy file is opened in X10, the layer names used in the currently active layer set will be 
retained and any other layer names in other layer sets will be discarded.

Files Created in Version X7 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X7 or 
prior, bear in mind the following:

1. Boxed Eaves

In Chief Architect X8, improvements to the generation of Boxed Eaves ensure that they extend into exterior 
rooms with “Use Soffit Surface for Ceiling” specified when located between the roof baseline and an interior 
room. In some legacy plans opened in Version X10, the Length value for Boxed Eaves may need to be 
modified in the Roof Plane Specification dialog.

2. Uppercase Text
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The Uppercase option was added to Text Styles in Version X8, whereas in Version X7 and prior, it was an 
option for Room Labels and Schedules only. In legacy plans opened in Version X8, any Schedules present in 
the drawing will be assigned a Custom Text Style, as will their associated Schedule Defaults. If any Schedule 
Default is set to Use Layer for Text Style and no objects are present on that layer, a new Schedule Text Style 
will be created and assigned to that layer. Room Labels are treated similarly: if any are present, they and their 
defaults will use a Custom Text Style. If a given Room Label or Schedule has been sent to layout more than 
once and was set to use different Text Styles in each layout view, it is possible that its appearance may be 
affected in some views.

Files Created in Version X6 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X6 or 
prior, bear in mind the following:

1. Built-in Appliances

In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base cabinets had 
incorrect sizing data. In legacy plans opened in Version X10, these appliances will not fit into the cabinet 
correctly and will need to be replaced. Built-in dishwashers are particularly affected.

2. Formatting of Bulleted and Numbered Lists

In Version X7, various improvements were made to the way lines of Rich Text are spaced. In legacy plans 
opened in Version X7, Rich Text objects with bulleted and numbered lists may require adjustments.

3. Chief Blueprint Font

The Chief Blueprint font was improved for Version X6, with decreased top and bottom spacing. The change in 
spacing may increase the overall height of text objects using this font in X6 files opened in Version X10. X5 
and prior legacy files will not be affected by this change.

For Files Created in Version X5 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X5 or 
prior, bear in mind the following:

1. Named Values for Doors and Windows

In Version X6, the Named Values door_style_name, door_type_name, and window_type_name were shortened 
to style_name and type_name. Any object labels or text macros using these Named Values in legacy plans 
opened in Version X10 will need to be replaced.

For Files Created in Version X4 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X4 or 
prior, bear in mind the following:

1. Roof Overhangs and Framing

In Chief Architect X4 and prior, roof overhangs were measured to the outside of the subfascia, whereas in 
Version X5 and later, they are measured to the outside of the fascia or shadow boards, if present. In legacy 
plans opened in Version X10, this will not affect the appearance of roof planes in floor plan view because in X4 
and prior, roof plane polylines represented the projected framing area whereas in Version X10 they represent 
the total projected area. But, the position of the fascia and subfascia will shift, as will the length of the rafters.

2. Door Swing Direction and Materials

In Chief Architect X4 and prior, exterior doors that swing outward display interior material on exterior side of 
door. This was corrected in Version X10. Doors modified to work around the old behavior could be affected in 
legacy plans opened in Version X5.

3. Door Swing Direction and Louvers
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Improvements to door louver direction may affect louvers in all doors with the exception of bifold doors.

4. Wrapped Door/Window Lintels and Window Sills

In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those that were not 
wrapped. In legacy plans opened in Version X10, the extents of wrapped lintels and sills will be adjusted so that 
they equal their Extend setting.

5. Cabinet Feet

The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork symbol to insert 
into cabinets effectively. In Version X10, the offset is set in the Cabinet Specification dialogs. When legacy 
plans are opened in Version X5, cabinet foot offsets are set to 0 and transferred to their containing cabinet, if 
one exists. Any customized or independently placed cabinet feet will be affected.

6. Object Labels in Cross Section/Elevation Views

If a “Label” layer is turned on in a cross section/elevation view and objects of that type are visible in the view, 
then those objects’ labels will display in that view when the plan is opened in Version X10.

7. Transparent Materials

In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing were visible in 
rendered views even when their Index of Refraction was set to 1.0. When legacy plans are opened in Version 
X10, Transparent materials with an Index of Refraction of 1.0 are transferred to the General Material class and 
assigned a Transparency value of 100%. This will not affect these materials’ appearance in ray trace views, but 
will make them completely invisible in rendered views.

8. Invisible Beams

The legacy Invisible Beam check box was removed from the Wall Specification dialog. When legacy plans 
are opened in Version X10, any Invisible Beam walls will be converted to Invisible Walls. 

For Files Created in Version X3 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X3 or 
prior, bear in mind the following:

1. Text Styles

The appearance of a number of objects that include text - including object labels, the North Pointer, Sun 
Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can now be controlled using Text 
Style. Their appearance may be altered somewhat in legacy plans opened in Chief Architect X10.

2. Light Sources

The illumination created by light fixtures and Added Lights was improved in Chief Architect X10. Lighting in 
legacy plans may appear noticeably brighter when viewed in version X10.

For Files Created in Version X2 and Prior
If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the following file 
management changes and structural enhancements:

1. Legacy file formats

Chief Architect 9.5 and prior files were saved in  .pl and .la the file formats. These file formats files are no 
longer supported and cannot be opened in version X10. 

2. Material textures, images, and backdrops

Chief Architect X2 and prior installed with a catalog of library content, including a selection of material 
textures, images, and backdrops. This library catalog is no longer installed with the program because it is now 
available for download on-demand, so it will be possible to open a legacy plan in version X10 and encounter 
numerous missing file warnings. To avoid this, we recommend using the Export Entire Plan feature in the 
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original program version to create a folder that includes the plan and all associated textures, images, and 
backdrops before opening this file in X10. This tool is renamed Backup Entire Plan in version X10.

3. Floor and ceiling finish thicknesses

In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and objects such as 
railings, stairs, landings, cabinets, fixtures, and furnishings measured their Floor to Bottom height from the 
subfloor. These objects now measure their Floor to Bottom height from the floor finish surface by default, so it 
is possible that you may notice height changes for these objects - particularly in saved, annotated cross section/
elevation views.

4. Riser heights and landing thicknesses

The default Best Fit Riser Height for stairs that do not reach the next level has been updated from 9” (225 mm) 
in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X10.

5. Auto Adjust Height

The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust Height check box. If 
a cabinet, fireplace, fixture, furniture, or other library symbol had Follow Terrain unchecked in version X2 or 
prior and was located in a room with a floor height other than the default for the current floor, then the object’s 
Floor to Bottom Height will change to equal that room’s floor height. The object’s position in the model will 
not change, however. 

6. Adjustable Thickness Walls

In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a legacy plan file 
is opened in version X10 and these wall types are detected, they are replaced by an updated, non-generic wall 
type. Framed walls and Railings will also acquire 1/2” (13 mm) thick layers of sheetrock on each side.

7. Stairwells defined by railings

Interior railings that used a generic, single-layer wall type drawn in older program versions will acquire layers 
of sheetrock when the plan is opened in version X10. This can affect the appearance of staircases where they 
join to a floor platform. To address this issue, select the railing and move it 1/2” (13 mm) away from the top 
edge of the staircase. 

8. Deck rooms

In legacy plans opened in Chief Architect X10, Deck rooms with Advanced Deck Framing built retain the 
framing but have Automatic Deck Framing turned off by default. Decks with no Advanced Deck Framing built 
are converted to Balcony rooms.

9. Material definitions and light sources

Settings in the Define Material dialog that affect materials’ appearance of brightness have been modified. The 
Ambient setting was removed, and the Diffuse setting for materials in legacy plans will be set to 100% when 
opened in version X10. 

The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified. Lights using Soft 
Shadows in legacy plans will be set to use Medium quality. The Light Diameter of light sources in legacy plans 
is capped at 4” (100 mm).

10. Structural Member Reporting

When a plan created in Chief Architect X2 or prior is opened in Chief Architect X10, Materials Lists are set to 
calculate Total Lineal Length. For a combination of lineal length and piece count, select Mixed Reporting in 
the Structural Member Reporting dialog.

11. Fill New Framing Members

In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief Architect X10 it 
applies to the entire plan. As a result, it is turned off by default in legacy plans opened in version X10.
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New and Improved Features
The following is a list of new and improved features 
in Chief Architect Version X10.

Installation
• The installed location of library content can now 

be specified when settings and content are 
migrated. 

• New New Plans/Layout dialog allows you to 
quickly specify the default units of measurement 
and template plan on first launch. 

• Library filters are now migrated along with the 
Core, Manufacturer, and Bonus Catalogs.

Program Overview
• A selected object’s Drawing Group is now 

reported in the Status Bar.

File Management

• The Backup Entire Plan  tool is now named 
Backup Entire Project when used in a layout file.

Project Management
• Icons in the Project Browser now denote views 

and layout pages that are currently open.
• Multiple views in the same Project Browser 

folder can now be selected as a group and then 
managed using their shared contextual menu.

• Saved views, plan files, and layout files can now 
be closed using the contextual menu in the 
Project Browser.

• The maximum number of Closet room boxes that 
can be created by the Space Planning 
Assistant  has been increased to 5.

Preferences and Default 
Settings

• Camera Defaults, Door Defaults, Base, Wall, and 
Full Height Cabinet Defaults, Dimension 
Defaults, and Text, Callout, and Marker Defaults 
can now be edited in groups.

• New Selected Edge Handle Fill color setting.
• Obsolete Command Flushing setting removed 

from the Preferences dialog.
• Obsolete Categories panel removed from the 

Preferences dialog.

Toolbars and Hotkeys
• New Saved Plan View Control and Active 

Dimension Defaults Control drop-down in the 
toolbars.

• The Control drop-down lists in the toolbars now 
feature a tool icon for easier recognition.

View and Window Tools
• Plan views can now be saved, and multiple plan 

views can be open at the same time.
• Improved how the Reference and Snap Grid lines 

display when zoomed out.
• The title bars and tabs of Wall Detail views now 

state the floor that the associated wall is drawn 
on.

• Each view window’s tab now features an icon 
indicating its type of view.

• The File Save and View Save message prompts 
now feature an icon indicating the type of file or 
view being closed.

• New Close All 3D Views  command. 

Creating Objects
• The obsolete Copy Region as Picture tool was 

removed from the software. 

Displaying Objects
• Improved the initial settings used by the Active 

Layer Display Options side window.

Editing Objects
• The Delete Objects dialog can now be used in 

camera views. 
• New  tool.
• The Transform/Replicate Objects dialog now 

adjusts an object’s height as well as its width and 
depth when resized. 

• Garden Beds is now an option in the Convert 
Polyline dialog. 

• New “Include in Schedule” Property in the 
Match Properties dialog.

• The Reflect About Object , Center Object 
, and Make Parallel/Perpendicular  edit 
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tools no longer recognize camera symbols as 
reflection or alignment axes. 

• Objects on multiple floors can now be selected 
and edited as a group. 

CAD Objects
• Two CAD Details, a “Details Template” and a 

“Schedule Detail” are included in installed Resi-
dential Template plan.

Walls, Railings, and Fencing
• A water table or cap can now be specified for 

pony walls.
• Pony walls can how have a Railing as the upper 

wall. 
• The top heights of railings can now be edited in 

3D views. 
• New options for displaying the upper and lower 

pony walls in plan view. 
• New No Post option for railing newel posts. 
• New Outline, Always, and Hide options for dis-

playing doors and windows in pony walls. 
• New Ignore All Off Angle Walls option sup-

presses all warning symbols for off-angle walls. 

Rooms
• New Lock Floor Top and Lock Floor Bottom 

radio buttons in the Room Specification dialog. 
• The version X10 template plans have a variety of 

new Room Types. 
• The Include in Schedule check box is now in the 

Room Type Defaults dialogs.
• New Select and Clear Transferrable buttons in 

the Match Properties dialog.
• New properties for electrical objects were added 

to the Match Properties dialog.
• When Select Room Before Wall in 3D is 

unchecked in the Preferences dialog, rooms can 
now be selected in 3D views using the Select 
Next Object  edit tool. 

Dimensions
• New Reach settings in the Auto Story Pole 

Dimension Defaults dialog.
• Auto Story Pole  dimensions now locate the tops 

of shed roofs.

• Improved the feedback of snap indicators while 
drawing dimension lines.

• The bottom strings of Auto NKBA Elevation 
Dimensions  no longer locate doors.

• Improved how Angular Dimensions  are linked 
to a Saved Dimension Default, which you can 
now specify.

Text, Callouts, and Markers
• Text can now be pasted directly into cross sec-

tion/elevation views.

Doors and Windows
• Wall surface lines now display for Doorways and 

can be displayed or suppressed for all types of 
doors. 

• Windows can now display Header Lines and the 
“Doors, Headers” layer was renamed “Opening 
Header Lines”. 

• New “Glass Slab” Door Style. The “Glass” Style 
was renamed “Glass Panel”. 

• New settings to control the display of doors and 
windows in pony walls. 

• Doors placed in Solid Railings now have a 
FRAMING panel in their specification dialog. 

• Removed abbreviations from Window Types 
reported by the %type% macro.

Cabinets
• Cabinet front items can now be selected by right-

clicking in the Cabinet Specification dialog pre-
view. 

• New Move Left and Move Right buttons for 
cabinet face items.

• Option to show cabinet face items as open was 
moved to the FRONT/SIDES/BACK panel of the 
Cabinet Specification dialog.

• New Percent Open setting for cabinet doors and 
drawers.

• Special cabinet shelf and rollout storage and 
organization objects can now be inserted into 
cabinets.

• Shelves and Partitions can now be included in 
schedules.

• Improved how cabinet fillers are named in cabi-
net schedules.
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Electrical
• Wall mounted electrical objects placed from the 

Library now use the Height value saved in their 
specification dialog instead of in the Electrical 
Defaults dialog. 

• Retired the deprecated Custom Light Intensity 
dialog. 

Schedules and Object Labels
• New Custom Fields allow you to easily create 

custom Schedule columns.

• New Find Object in Plan  edit tool for line 
items in schedules and the Materials List.

• New Open Row Object(s)  edit tool for line 
items in schedules and the Materials List.

• New Use Default Formatting option for custom 
object labels with macros.

• The Supplier for most objects can now be set in 
their specification dialog rather than in the Com-
ponents dialog.

• New Column to Include for Supplier in all 
schedules except Framing and Room Finish.

• New Columns to Include for energy value infor-
mation in Door and Window Schedules.

Foundations
• Brick ledge lines are now drawn in floor plan 

view. 

Stairs, Ramps, and Landings
• Stair Railings and Railings at Walls can now be 

specified independent of one another. 

Roofs
• New Dutch Gable Roof option for automatic 

roofs. 

Framing
• Wall headers can now display in floor plan view 

and have improved label functionality. 
• Improved how Nominal size is reported for fram-

ing specified as Lumber in schedules.

• Improved labels for Joist Direction Lines  
now report the framing Structure Type, and in 
plans using US Units, fractional inches are used 

instead of whole inches unless the Structure Type 
is “Lumber”. 

• General Framing objects are now drawn on the 
new “Framing, General” layer. 

• The default fill style for joists, rafters, General 
Framing, and headers in floor plan view can now 
be specified. 

• The default fill style for wall framing in Wall 
Detail views can now be specified.

• Automatic Height is now unchecked automati-
cally if the selected roof framing member’s 
height is edited outside of its specification dialog. 

• New PSL and VSL structural member Types for 
framing. 

Trusses
• The No Special Snapping setting now disables 

additional truss snapping behaviors and becomes 
checked automatically if you place a truss end at 
a non-default location. 

• The Maximum Height setting was removed from 
the Roof Truss Specification dialog. 

• Obsolete Ceiling Step setting was removed from 
the Roof Truss Specification and Framing 
Defaults dialogs. 

The Library
• The location of library content on the system can 

now be specified.
• Individual Library Browser catalogs and folders 

can now be searched.
• The preview for a selected material in the library 

is now displayed on a sample Sphere, Cube, Tea-
pot or 2D Plane object.

• Multiple materials in the User Catalog can now 
be edited as a group.

• The Replace from Library function can now be 
overridden by holding down the Alt key.

Custom Symbols
• Free standing symbol objects can now be rotated 

in all directions in 3D views using the edit han-
dles. 

• New Inserts into Wall attribute for custom sym-
bols.
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Other Objects
• Distribution Regions and Paths have new spacing 

and scaling options.
• The Distribution Path Specification dialog now 

has an ARROW panel.
• The objects assigned to Distribution Regions and 

Paths can now be replaced directly from the 
library.

Materials
• New Plane  shape option for the material pre-

view pane in the Define Material dialog. 
• New Ambient Occlusion Map option for materi-

als.
• New Metallic option for General Materials.
• New Roughness Map and Metal Map options 

for some Material Classes.

3D Views

• New Virtual Reality  option in Perspctive 
cameras and overviews lets you view the model 
using a VR headset.

• The Camera Defaults dialog was replaced by 
multiple defaults dialog for the different 3D View 
tools. 

• The obsolete Display Callouts for Sections/Ele-
vations check box was removed from the 
Camera Defaults dialogs. 

• The Always Display Active Cameras check box 
was moved from the Camera Defaults dialog to 
the 3D View Defaults dialog. 

• New Ray Casted Sun Shadows option for cam-
eras improves quality of shadows created by sun 
light. 

• The Open Object  edit button is now avail-
able when multiple cameras are selected. 

• Cameras now follow their floor when floor levels 
are added or exchanged. 

• The obsolete Remove 3D tool was removed from 
the program.

• The obsolete Restrict Floor Camera to Room 
check box, View Panel Factor settings, and Back-
drop panel were removed from the 3D View 
Defaults dialog. 

• The obsolete Advanced Camera Options dialog 
was removed from the program. 

• The obsolete Remove Wall Within and Unless 
Opening scene clipping options were removed 
from the Camera Specification and Defaults dia-
logs. 

Rendering and Ray Tracing

• The Open Object  edit button is now avail-
able for multiple selected cameras. 

• The number of lights that can be on in a camera 
view can now be specified. 

• Enhanced Adjust Lights dialog. 
• Lighting in 3D views is no longer confined to the 

same room that the camera is located in. 
• Parallel Light sources are no longer supported. 
• New Light Sets allow you to control which lights 

are used in each camera view, regardless of their 
distance from the camera.

• The Ambient Light settings were moved from 
the 3D View Defaults dialog to the Rendering 
Technique Options dialog. 

• New Physically Based  Rendering Technique 
models reflections on non-mirror surfaces like 
counters and appliances. 

• Shading Contrast can now be turned off or on in 
Vector Views. 

• When a light or light source is placed or copied 
and pasted, it will always be on initially. 

• A light source’s Position Indicator now displays 
in all Rendering Techniques aside from Line 
Drawing. 

Pictures, Images, and Walk-
throughs

• Backdrops can now be specified on a per-camera 
basis as well as for each Rendering Technique. 

• Improved the transitions between different 
speeds in walkthroughs. 

• The obsolete .tga image file format is no longer 
supported. 

• Obsolete Line Weight Scale setting removed 
from the Export Picture dialog. 

Importing and Exporting
• Added support for AutoCAD® 2018 file import. 
• Saved cameras and multiple floors can now be 

exported to the 3D Viewer app.
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• 360 Panorama images previously saved to disk 
can now be uploaded to your online account.

Terrain
• New Make Terrain Hole(s) Around Building(s) 

 edit tool provides manual control over the 
terrain holes that are automatically generated 
around buildings.

Materials List
• Line items representing multiple objects can now 

be expanded to display each object in its own 
line. 

• Mouse over any cell with a formula or count to 
see a Tool Tip with information about its con-
tents. 

• Custom formulas can now be applied in the 
Materials List.

• New Update to Master  and Update from 
Master  toolbar buttons. 

• New Save Active Materials List  toolbar but-
ton. 

• New Assemble Wall Plates, Deck Planking, and 
Rim Joist options for Materials List Buy Lists.

Layout
• Layout view boxes are no longer restricted to a 

rectangular shape and can be edited like a closed 
polyline.

• New PLAN VIEW and CAMERA VIEW panels in the 
Layout Box Specification dialog. 

• Color  can be toggled on or off in individual 
views sent to layout. 

• The position of a layout box can no longer be set 
in its specification dialog. 

Printing and Plotting

• New Watermark  option for plan and layout 
files. 

Ruby Console
• New “program_version” Ruby command.
• New Named Value pairs for doors and windows.
• New “include_in_schedule” Named Value pair 

for a variety of objects.
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